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Contact and Support Information
Return to Table of Contents.

Product and account information can be accessed by visiting Customer Support online at support.cch.com.
In addition to product and account information, the Customer Support site offers answers to our most
frequently asked questions, forms release status, Knowledge Base articles, training videos, and operating
systems compatibility. Access to these features is available 24/7.

The following website provides important information about the features and updates included in all CCH
ProSystem fx Tax releases: Release Notes.

Visit the Application Status web page to view the current status of our CCH applications. The Application
Status web page is updated every 15 minutes.

Go to Contact Us to find information on topics such as Sales and Billing, as well as options to Open a
Support Case or Chat with a Representative if you need assistance.
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https://support.cch.com/
https://support.cch.com/updates/Tax/releasenotes.aspx
https://support.cch.com/appStatus/
https://support.cch.com/Contact


Information in Tax Release Notes
Return to Table of Contents.

CCH® ProSystem fx® Tax Release Notes inform you of the enhancements and updates that have been made
to Tax products and systems with the current release.

Updates provided in the Release Notes include the following:

Contact and Support information
Updates to the Tax technology (electronic filing updates, Pro Forma/Recall, Organizer,
technology enhancements)
Updates made to Tax products (form additions and updates, diagnostic updates, changes
caused by regulatory updates)

To access a list of CCH ProSystem fx Tax Release Notes for the current year and for prior years, visit the
Release Notes page on our Customer Support site.
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Highlights for Release 2023.02070
Return to Table of Contents.

Tax Updates

Fiduciary
Batch Extensions. South Carolina and Maryland are now available for batch extension processing with this
release.

Exempt Organization
Federal Form 7004. Form 7004, Application for Automatic Extension of Time to File Certain Business
Income Tax, Information, and Other Returns, is available to file on this release. Please see this Knowledge
Base Article on how to generate and file this form electronically. This form is available to generate an
extension for Form 1120-POL, U.S. Income Tax Return for Certain Political Organizations.

Electronic Filing Updates

Individual

Arkansas Arkansas Extension Washington

Arkansas Estimates
Kentucky Cities — Louisville
Extension

Washington Extension

Corporation

Georgia Kentucky Consolidated Missouri Consolidated
Iowa Consolidated Massachusetts Consolidated New York City Consolidated
Kansas City — Form 108
Extension

Michigan Consolidated Vermont

Kentucky Combined Michigan MBT

S Corporation

Georgia
Kansas City — Form 108
Extension

New Mexico

Hawaii Michigan MBT

Partnership

Georgia Michigan MBT New Mexico
Hawaii Montana Rhode Island
Kansas City — Form 108
Extension
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https://support.cch.com/oss/ml/kb/solution/000272982
https://support.cch.com/oss/ml/kb/solution/000272982


Exempt Organization

Federal Extension — Form 7004
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Tax Product Updates

Individual (1040) Product Updates
Return to Table of Contents.

Federal
Form EF 1040NR. Diagnostic 47243 will not issue when Schedule C gross income is greater than
withholding reported on Form 1040NR.

Form 7203. Part II, Shareholder Debt Basis information pro formas correctly from tax year 2022 to 2023.
This requires a recalculation of the 2022 return before executing the Pro Forma. Optionally, a manual
entry of the information in tax year 2023 can be used.

Form 8911. Personal use credit entered on Credits > 8911 - Alternative Fuel Vehicle Refueling Property
Credit (Interview Form P-25, Box 60) no longer changes when Filing Status Comparison is selected to print.

Alabama
Form NOL-85, Line 7d now carries from Form 40, Page 2, Line 4.

Schedule RS prints when

There are only exempt entries in Part I

There is an exclusion in Part II and/or Part III

There is taxable retirement income

Arizona
Form 140, Page 6. The automatically calculated Arizona Families Rebate subtraction will appear.

Form 355 current year credit will appear on Form 301 regardless of carryovers.

Illinois
The Expanded EITC Worksheet no longer produces if the taxpayer is a dependent of another.

Maine
Itemized deductions are now forced for nonresident aliens.

Massachusetts
Schedule OJC, Schedule B — Interest and Dividends, Line 11 rounds to 4 decimal places.

Minnesota
Form M1, Line 4, standard deduction limitation Line 2 now reflects the subtraction.

Schedule M1SA, Line 5 and 26. Worksheet has been updated to correctly reflect calculation for Line 5.
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Nebraska
The signature block now properly prints the firm's name, address, and PTIN.

Ohio — Ohio Cities
Ottawa Hills joined RITA on January 1, 2024. Generic Form R will no longer be prepared for this city.

The city of Akron has changed their design of Form IR. The new version is similar to the Generic Form R.
The city has confirmed they will accept returns using the Generic Form R. As a result, the Generic Form R
will now be produced instead of the Akron Form IR.

Wisconsin
Multiple entries for qualified preservation costs are now available in Worksheet View.
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Corporation (1120) Product Updates
Return to Table of Contents.

Alabama
Form BPT-NW prints balance sheet information when the ET-1 form is activated.

Electronic Filing
Diagnostic 46458 no longer issues incorrectly for fiscal year filing returns.

Iowa
IA Form 124, Part II, Line 1 pulls the prior year NOL carryover instead of the current year NOL carryover.

Massachusetts
Schedules M-1, U-CI and U-M are updated to reflect the new federal energy efficient building deduction
on Form 7205.

New York — New York City
Form NYC 2.4, current year negative net operating loss is limited to zero.
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S Corporation (1120S) Product Updates
Return to Table of Contents.

Federal
Pro Forma. The Pro Forma program has been updated to no longer adjust the shareholder basis print code
during the Pro Forma process.

Delaware
Form SCT-TAX. The percentages present on Form SCT-TAX, along with fields related to them, calculate
and print properly.

Iowa
Form IA 1120S consolidated will no longer show the 1120F prior year payments on the Schedule C.

Nebraska
Schedule PTET. Electing to redistribute pass through PTET credits from Schedule K-1N has been added to
Nebraska > Credits and PTET > PTET Credit from Pass-Through Entity (Interview Form NE4, Boxes 112-114).
Select the year that the credit is related to, and will display in the appropriate column on Schedule K-1N
and Schedule PTET.

New Jersey
Form CBT-100S now carries New Jersey State and other states' income taxes deducted on the federal
return to Form CBT-100S, Page 9, Schedule K, Part IV-A - Analysis of New Jersey Accumulated Adjustments
Account.

Form CBT-100S, Part V, Column E, Share of Pass-Through Business Alternative Income Tax, carries
from Schedules NJ-K1, Line 8.

Form PTE-100, Line 1, Distributive Proceeds utilizes single factor allocation, without considering
whether multiple factors are entered and used for other states.

Form PTE-100, Pass Through Business Alternative Income Tax Return, Member Directory, Column C,
Member's Share of Distributive Proceeds, agrees with the sum of the shareholder's Schedule NJ-K-1, Part
II, Line 1, S Income/Loss allocated to NJ, plus Line 4, Gain/Loss on disposition of assets allocated to NJ.

Nonconsenting shareholders now automatically carry tax to Form NJ-1040-SC; Form NJ-1080-C, Schedule A;
Form CBT-100S, Schedule K, Part VII; and CBT-100S, Page 1, Line 11a.

New York
Pass Through Entity Tax (PTET) estimated tax payments can now be specially allocated to shareholders by
using code 34851 to specially allocate New York State PTET estimated tax payments and code 34852 to
specially allocate New York City PTET estimated tax payments.

North Carolina
Form 401S, Page 3, Schedule K calculates Lines 6 and 7 based on total additions and deductions reflected
on Form NC-PE.
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Rhode Island
RI Schedule K-1. The "Included in PTE" box will fill for any shareholder included in the filing of the RI-PTE.

Tennessee
Schedule PL is limited to zero when a negative value is calculated.

West Virginia
Schedule EK-1, Line 1 matches WV Schedule K-1, Line 1.
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Partnership (1065) Product Updates
Return to Table of Contents.

Federal
Schedule K-1, Box 20, Code AR. The IRA Taxpayer Identification Number will not include the commas
when the option to print commas in amounts is present on General > Return Options > Processing Options >
Line 47 (Interview Form 2, Box 61).

Arizona
Arizona Form 8879 correctly displays the refund amount if applicable.

Schedule MSP generates for the second election year even if Arizona market sales from services or
designated intangibles is zero.

Arkansas
AR1100PET, Page 3, Line 11 will no longer double the amount of guaranteed payments.

California
Schedule L, Line 21b now uses the override entered on California > Schedules L and M > Schedule L
Overrides - Liabilities and Capital > Partners' capital - Beginning of Year (Interview Form CA7, Box 110). In
addition, Schedule K-1, Line L, Columns b and c now use the overrides entered on Schedule M-2 Overrides
> Lines 2 and 4 (Interview Form CA9, Boxes 181 and 183).

Colorado
The program has been updated to post a December payment date on the fourth DR 0160EP voucher when
the SALT election has been made.

Connecticut
Form CT-1065/CT-1120SI, Part I Schedule C, Lines 10 and 11, no longer applies a 25% calculation to the
fourth prior year input entered in Connecticut > Income/Deduction > Additions and Subtractions >
Disallowed Bonus Depreciation / Disallowed Sec. 179 Depreciation (Interview Form CT17, Boxes 93 and
103).

Georgia
Estimates can now be prepared when the election to pay the entity tax is not selected in the current year
by entering the net estimated tax - override or entering the voucher overrides on Georgia >
Payments/Penalties > Estimate and Application of Overpayment (Interview Form GA6, Box 73).

Illinois
Code ILC will no longer be active for payments.

Sch K-1-P, Line 31 does not show amounts related to Section 179.
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Iowa
IA Schedule K-1

Line 12 no longer doubles the other income from federal when the partners are any type
other than individuals

Part III, Line 1 no longer calculates when the PTET election is selected

Part III, Lines 1 and 2 allocation codes are now available

Kentucky
Kentucky Form PTET-CR will no longer produce for partners/shareholders marked as exempt.

Maryland
Form K-1,Section D, Line 1 has been updated to include MD 510, Line 15.

Nebraska
Form 1065N. Electronic Filing has been updated for Schedule PTET when there are credits for tax years
2018 through 2022 and the election to be taxed as a pass through entity has not been made.

Schedule PTET. Electing to redistribute pass through PTET credits from Schedule K-1N has been added to
Nebraska > Credits and PTET > PTET Credit from Pass-Through Entity (Interview Form NE5, Boxes 110 -
112). Select the year that the credit is related to, and will display in the appropriate column on Schedule
K-1N and Schedule PTET.

New Jersey
New Jersey 1065, Page 2, Line 15e includes meal and entertainment from rental activity.

New York
Diagnostic 55909 will not issue for an invalid email address. Technology will issue an error message for an
invalid email address.

Oregon
Grantor trusts and single member LLC's will now be recognized as individuals when Form OR-21 is filed.

Pennsylvania
PA Form 179. Limits are now in line with Federal 179 limits.

PA Schedule NW, Part 2. Nonresident disregarded entities can now appear.

Texas
Exclusions from foreign dividends entered on Federal > Income/Deductions > Dividends (1099-DIV) > Total
ordinary dividends (Interview Form B-2, Box 53) or the percentage entered in US bond interest amount or
percent in Box 1A (Interview Form B-2, Box 100) now calculate as a percentage if between 0 and 1, and as
an amount otherwise.
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Fiduciary (1041) Product Updates
Return to Table of Contents.

Federal
Extensions > Extensions > Automatic extension columns are no longer misaligned. This item was initially
added in the 2023.02060 release.

Schedule K-1. The Schedule K-1 statements description for qualified business income deductions from
cooperatives is revised.

California
The city, state, and zip code fields have been split into separate sections at the top of Form 541-T.

Iowa
ESBT, Other deductions no longer shows 75% of the federal QBID amount and now shows 100% of the
federal QBID amount.

Part I, Line 1 is completed for all beneficiaries instead of just residents.

Part II, Line 9 no longer includes U.S. Government interest/dividends.

Kentucky
KY Form 741. The preparer email address populates correctly.

Massachusetts
Form 2, Page 3, Lines 35 and 36 are no longer switched. This impacted the printed return only. This item
was initially added in the 2023.02060 release.

Nebraska
The 1041N preparer information now prints correctly in the signature block.
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